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1 Introducciéon

El presente documento describe cuales son las tareas basicas que se pueden ejecutar en la explotacién
de la herramienta Oracle SQL Developer.

2 Conceptos basicos

Oracle SQL Developer es una herramienta gréafica para el desarrollo en bases de datos Oracle. Permite
visualizar objetos de base de datos, ejecutar sentencias SQL y scripts SQL, y editar y depurar sentencias
PL/SQL. También permite ejecutar informes ya proporcionados o los creados y salvados por el usuario. SQL
Developer simplifica y mejorar la productividad a la hora de desarrollar sobre bases de datos Oracle.

Cabe destacar que Oracle SQL Developer solo soporta versiones 9 o superior.

La version homologada de SQL Developer esla 1.2.1

En la pagina Web de Oracle existe informacion adicional:

http://www.oracle.com/technology/products/database/sql developer/index.html

3 Funciones elementales

Aunqgue se han recogido en el presente manual las funciones mas elementales que se realizaran con la
herramienta, en la pagina web indicada se explica detalladamente toda la potencia de esta aplicacion.

3.1 Operativa basica

El Oracle SQL Developer es una herramienta construida en torno a un interfaz principal que permite
navegar por un arbol jerarquico de objetos contenidos en bases de datos y realizar operaciones sencillas sobre
ellos. Proporciona ademas alguna herramienta adicional, especialmente un area para ejecutar sentencias SQL y
PL/SQL.

3.1.1. Interfaz principal

El interfaz principal del Oracle SQL Developer es sencillo: en general se utiliza la parte de la izquierda
para buscar y seleccionar objetos y la parte de la derecha para mostrar informacion sobre dichos objetos.

La ventana de la izquierda tiene dos pestafias:

= “Connections”: muestra un listado de las conexiones a bases de datos que se hayan creado. Para
crear una nueva, se puede seleccionar del menu de contexto de “Connections” la opcion de “New
Database Connection”. También es posible importar un fichero XML que contenga definiciones de
conexiones, o exportar las conexiones actuales.

=  “Reports”: muestra un listado de los informes que puede proporcionar SQL Developer, tanto
predefinidos (como por ejemplo una lista de las tablas que no tengan clave primaria) como
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definidos por el usuario.

Bajo estas pestafias se muestra un arbol jerarquico de objetos, clasificados en funcién de su tipo. Si se
selecciona un nodo (por ejemplo, “Tables”, que contiene las tablas para una conexion) los objetos mostrados

pueden filtrarse en funcién de su nombre. El usuario puede definir el filtro utilizando el icono W . Para dejar de

utilizar dicho filtro, se escogeria la opcién de “Clear Filter” en el meni de contexto de dicho nodo, tal y como se
muestra en la figura.

Qconnections | af9Reports =

@ 7 '

E]---ﬁ?il Connections

=&Y DEConrectiont

{3 Tahles (342
-3 views | B Creste TABLE
e (a8 Indexes | 7 apply Fiter ..
E""!'_I'[:ﬁ Packages EE Refresh
#-{ 3 Procedure o ;
= . Clear Eiltter
|_,@ Functions
(- 8 Triggers Help
& [E Types

Ademas de dicha opcién también se tendra la posibilidad de crear un nuevo objeto del tipo del nodo
seleccionado.

Si se selecciona un objeto de un tipo determinado, su menu de contexto ofrecera operaciones especificas
de ese objeto (por ejemplo, “Table>Truncate” para borrar una tabla, “Rebuild” para reconstruir un indice, etc.)

La parte de la derecha del interfaz muestra informacién sobre los objetos seleccionados, organizada en
diferentes pestafias. Por ejemplo, al seleccionar una tabla denominada “Books” se podria mostrar lo siguiente:

[(BOOKS
Cu-:;lumns_ Data | Indexes | Constraints | Grants | Statistics | Column Statistics T.ri5.|g

A T B Actions...

Column Mame | Data Tupe MHullable
BOOK_ID WaRCHARZ20) Mo
TITLE WaRCHARZ(BO) Mo
AUTHOR_LAST _MAME WaRCHARZ[30) Mo
AUTHOR_FIRST_MA... WARCHARZ[30) Yes
RATIMG HNUMEER Yes

Para los objetos de tipo tabla, existe la pestafia “Data” que permite ver y modificar los datos almacenados
en la misma.

Para la mayoria de objetos, existe una pestafia “SQL”, que muestra la sentencia SQL de creacion de

dicho objeto. Desde las distintas pestafias los datos se pueden exportar utilizando la opcién de “Export” del
menu de contexto.
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3.1.2. Depuracién

El SQL Developer se puede utilizar para ejecutar y hacer “debugging” de funciones y procedimientos
PL/SQL. Para ejecutarlas, se puede seleccionar dicha funcién o procedimiento en la parte izquierda del interfaz
y después escoger la opcion de “Run” del menu de contexto.

Existen dos requisitos para poder realizar la depuracion. El primero es que el usuario debe tener permisos
para realizar la operacion, que se otorgan mediante:

grant debug any procedure, debug connect session to NOMBRE_USUARIO;

El segundo es activar la depuracién en modo local para no tener que establecer una conexion desde la instancia
de Base de Datos hacia el equipo que ejecuta la depuracion.

!J Preferences

&} Erwiranment PL/SOL Dehugger

o Aecelerators
+}-- Code Editar
71 Database

[¥] Use Probe Debugaer to debug PLISGQL

i} Debugger
Documentation

- Exbensions

File Types

- Migration

- PLYSQL Compiler Options

- SOL*Plus
i S0L Farmatkter
i Web Browser and Proxy

i Awvuda Aceptar i i Cancelar ‘

Para realizar el “debugging”, si el cédigo aun no ha sido compilado para “debug” se puede escoger la
opcion de “Compile for Debug” del menud de contexto. Después se edita el procedimiento (por ejemplo haciendo

doble clic sobre su nombre) y se utiliza el icono para comenzar la ejecucion en modo de “debug”, lo cual
hace aparecer la pestafia de “Debugging — Log”. En esta pestafia existe una barra de herramientas mediante la
cual se puede controlar la ejecucion (con las opciones habituales para ir paso a paso, hacer pausa, etc.).

Pueden afiadirse “breakpoints” haciendo clic sobre el margen situado junto al editor de cédigo (los

nameros de linea apareceran si se escoge la opciéon de “Toggle Line Numbers” en el mena de contexto). Estos
“breakpoints” pueden editarse para establecer diferentes condiciones, como se muestra en la figura.
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IQcornections | af9Rep... L] 2 UsT_A_RATINGZ

RNY B & & ok

Elafl Connectionz 1| ' CREATE 0B BFEPLACE

IE!E: DEConnection @ =l PROCEDURE list a ratingZ(in rating 1
LEI Tables 3 matching title VARCHAR? (501 :
EE Inclexes g T

Eg Era;::g;ses : E r Definition |/ Conditions |/ Actions |
B2 LST_A_RATING2 & BEc  ‘Condtion:
' ----- Eﬁ Functions [+ o |
-8 Trigoers 10 ,
I-_EI s ' o Ther Options:
Ea Secuences 12 J' Ereak for All Threads
{E Materialized Yiews 13 o I_J) Break Only for Threads Mamed

3.1.3. SOL Worksheet

Desde “Tools>SQL Worksheet” se puede acceder a esta herramienta del SQL Developer. Puede
utilizarse para escribir y ejecutar sentencias SQL, PL/SQL y SQL*Plus.

El interfaz tiene dos secciones principales:

Enter SQL Statement

La seccion superior es donde se escriben las sentencias que se pretende ejecutar. En el caso de que
sean varias, las sentencias que no sean PL/SQL se deben terminar con un punto y coma o en una linea nueva y
con una barra (/), y las sentencias PL/SQL con una barra (/) y en una linea nueva. Para dar un formato
adecuado (por ejemplo pasando a mayusculas los nombres de las sentencias, etc.) se puede escoger la opcion
“Format SQL" del men( de contexto.

Ademas, se pueden arrastrar a esta ventana algunos objetos desde la seccion de “Connections” situada a
la izquierda en el interfaz principal del programa. Arrastrando una tabla, se crea automaticamente una sentencia
SELECT. Arrastrando una funcion o procedimiento, se crea un bloque de texto.

B

Tras introducir las sentencias, pueden ejecutarse mediante el icono de “Execute Statement” (ejecuta

la sentencia sobre la que se encuentra el cursor) o mediante el icono “Run Script” (que ejecuta todas las
sentencias que existan en la seccién “Enter SQL Statement”, emulando una parte de las caracteristicas de
SQL*Plus).

Pestafias

La seccion inferior del interfaz muestra las siguientes pestafas:

= Results: muestra los resultados de la Ultima sentencia ejecutada.
= Explain: muestra el resultado si se selecciona la accion de “Execute Explain Plan” mediante el

icono correspondiente.
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El plan de ejecuciéon muestra un arbol con la jerarquia de las operaciones que forman la
sentencia. Para cada operacion, se muestra el orden de las tablas referenciadas por la sentencia,
el método de acceso a cada tabla, el método de unién para las tablas que hayan sido afectadas
por operaciones de tipo JOIN, y operaciones como filtrado, ordenado o agregado. Ademas se
muestran columnas con informacién sobre optimizacion (por ejemplo el coste de cada operacion),
particionamiento y ejecucion paralela.

> Resuts | (& script output | EEsplain | ADEMS Output @ owia, Output

Operation | Optimizer Cost
=h-[= SELECT STATEMENT CHOOSE
== SORTIORDER BY)
D TABLE ACCESS(FULL) BOAELAR BOAELAE AMNUMCIOS

= Script Output: muestra el resultado si se ha utilizado el icono “Run Script”.
= DBMS Output: muestra la salida del paquete DBMS_OUTPUT.
=  OWA Output: muestra la salida del Oracle Web Agent.

3.1.4. SQL*Plus

Se puede ejecutar en “Tools>SQL*Plus”. Muestra una ventana de comandos en la que se pueden
introducir sentencias SQL y SQL*Plus para acceder a una base de datos determinada.

Para que esta herramienta esté disponible, el sistema en el que se esta utilizando el SQL Developer debe
tener un directorio Oracle Home que contenga el ejecutable SQL*Plus. Si no se dispone de este ejecutable, tal y
como se menciona en este documento se pueden utilizar sentencias SQL*Plus en la “SQL Worksheet”, si bien
no todas estan soportadas. Para un listado de sentencias soportadas se puede consultar la ayuda que
acompafia al programa.

4 Capacidades

A continuacion se describen las capacidades o tareas a nivel global mas importantes que permite
desempeniar la aplicacion. Para profundizar en alguna de ellas mas alla del presente texto, nada mejor que
consultar la documentacion oficial de la herramienta proporcionada por oracle.

4.1 Crear conexiones

Para acceder al panel de crear conexiones debemos pulsar sobre el icono indicado en la figura, el cual se
encuentra en la pestafia “Connections”.
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lﬂ Oracle SQL Developer : DD

File Edit “iew Mavigste
DEHa 9@

<E@§;ec‘t;ns

mnnnediuns

=-E] 80D CURSO

Podemos crear y testear tantas conexiones a bases de datos como queramos. Destaca la capacidad que
tiene para conectarse a otro tipo de bases de datos a parte de Oracle. En concreto podemos acceder, tal como
se ve en la siguiente imagen, a BDD de tipo Access, MySQL y SQLServer. El motivo principal por el cual han
implementado esta posibilidad, es el de dar la posibilidad de exportar datos de dichas BBDD hacia nuestra BD de

Oracle.

I New / Select Database Connection

Cu:unneu:ti...l Connecti...

EDD_CL... cursodir...

X

Connection Mame | |

Uzernatme |

Passwiard |

|:| Save Passward

Oracle | Access |MySGL | SOLServer |

Role

Connection Type () Basic () TNS () Advanced

Hosthgtne | localbost |
Port 1521 |
) sp |xe |
() Service name | |
Status :
Anuda ] ’ Save ] ’ Clear ] ’ Test ] ’ Connect ] ’ Cancelar
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También podemos ver en la imagen anterior que se nos permite almacenar los datos de conexién a todas
las BBDD que queramos. Mediante el parametro “Connection Type” podemos elegir introducir los parametros de
la conexion de forma manual, seleccionar una de las BBDD definidas en el fichero thsnames.ora o bien introducir
los datos con formato URL de JDBC.

Hay que decir que la herramienta SQL Developer necesita conectarse a una version de Oracle 9i o

superior para acceder a todo su potencial. La conexidn con Oracle 8 es posible pero no todas sus opciones
qguedan disponibles, por lo que se desaconseja su utilizacion.

4.2 Explorar objetos

La herramienta SQL Developer cuenta con un explorador de objetos basado en arbol. Gracias a esto
podemos acceder a todos los objetos que componen nuestra BDD de una manera facil e intuitiva, tal como
podemos observar en la siguiente imagen.

lﬂ Oracle S0L Developer : TABLE CURSO.EQUIPO_LANDER@BDD ELRSH s I EIIEI

File  Edit “iew Mavigate Run  Debug  Source  Migration  Tools  Help

FoEd 90 XBER O-0- %- B89@ e

TR Connections |_@ Repatts | E]H_@- BOD_CURSO | FHEQUIPD LANDER LE':_';'@
B®Y | Columns | Data | Constraints | Grants | Statistics lcial vl g
............. : 1A
B Connections B E X R st Firter:].ﬂu:tin:ur: %
-} BDD_CURSO § copecuro (@ nomere |
=- %5'83 1 1 Athletic
w1 cocHe : : Barqa_
E COMDLICTOR 3 3R Sociedad
- Eaupo 4 4 Maves

-8 EquiP_Eva,
- EaUIPO_LANDER
rl- [ EQUIPOEDURNE
#- JGADOR

w- JuGADOR_Eva
=-EH JUsADOR_LAKNDER
B cobusADoR
- H MOMERE

B copEauURo
& JUGADOREDURNE
-5 PRUEBA, — —!
G FB o fha el |

All Rowvs Fetched: 4 | Edliting

4|

Entre los objetos a los que tenemos acceso destacan los siguientes:
» Tablas, vistas e indices.

« Pagquetes, procedimientos, funciones y disparadores.
e Tipos.
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» Secuencias.

* Vistas materializadas y logs.

e Links de la BDD.

» Directorios.

e Esquemas XML.

« Papelera de reciclaje (con 10g y superiores)
»  Oftros usuarios.

Para facilitar la visualizacién de multiples objetos han implementado una vista por pestafias, por lo que no
supone un problema tener que analizar varios objetos simultaneamente.

Por dltimo, otra caracteristica resefiable es la de que los objetos del mismo tipo cuelgan juntos de un
mismo nodo del arbol de visualizacion. Ademas, podemos aplicar filtros a cada nodo para restringir ain mas qué
es lo que queremos visualizar.

4.3 Crear objetos

A la hora de crear objetos, SQL Developer nos facilita la tarea gracias a los didlogos/formularios de
creacién que tiene para cada tipo de objeto. Como muestra de las capacidades de dichos dialogos a
continuacion se muestra el correspondiente a la creacién de una nueva tabla.

'1 Create Table x|
Schems: | CLRSO - JY— g
Matne: | TABLE1 |
Table Type: (30 Mormal () External () Index Organized () Temparary (Transaction) () Temparary (Session)

..... m Colunns: Column Properties
------ Primary Key ( |¢|
------ Unigue Constraints p— Wame: |COLUMN1 |
""" Foreign Keys | ® | Datatype: (2 Simple () Complex
------ Check Constraints
...... M— - Type: | VARCHAR2 |
------ Column Sequences )
------ Storage Options =1 Shiz |4EIEID |
------ Lok Parameters Urits: | - |
[=h Partitioning
Partition Definition=
e Subpartition Templates
...... Comment Default: | |
""" boL [ cannot be MULL
Camment:
FY
|| v |
-
Avuda Aceptar J | Cancelar
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Entre los datos soportados incluye soporte para:

e Tablas externas.

e Tablas organizadas por indice.

e Tablas temporales.

e Tablas particionadas (Range, Hash y List)

En la creacion de nuevas tablas podemos especificar secuencias y disparadores para ejecutar antes de
insercion de datos para rellenar una columna con valores.

4.4  Modificar objetos

SQL Developer a la hora de modificar objetos también nos ofrece unos dialogos especificos para facilitar
la tarea. Entre dichos didlogos se encuentran:

e Table -> Rename. Para renombrar una tabla.

e Column -> Add. Para afadir una columna a una tabla.

* View -> Compile. Para compilar una vista en busca de errores antes de su ejecucion.

e Index -> Rebuild. Para reconstruir un indice o alguna de sus particiones. Si un indice no es
usable, una reconstruccion con éxito lo convierte en usable.

«  Procedure -> Debug. Poco que explicar aqui, permite debuggear un procedimiento.

« Trigger -> Disable. Para deshabilitar un disparador.

e Sequence -> Drop. Eliminar una secuencia.

e Materialized View -> Change Parallelism.

e Synonym -> Drop. Eliminar un sinénimo.

» Database Link -> Test. Testear el funcionamiento de un enlace de BD.

« Recycle Bin -> Purge. Vaciar la papelera de reciclaje.

La mayoria de los objetos tienen un didlogo de edicion general asi como uno de modificaciones
especificas disponible mediante el menua contextual del boton derecho del raton.
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3 Types
Eﬁ Sequences
- {F3) Materislized Views

EQ_J_, Explare Directary
@ Materializ
33 @ Matepad
SYRIORY NS
- {39 Puklic Syr @ tiozills Firefox
{88 Dstabaze | & Internet Explorer

{58 Public Dat: [ wora
@ Directorie

5 ®ML Sche Eet

B

L@ other Use Frivileges k
Caching ]
Compression L
Cuery Revrite ]
Mo Paralelism
Liooyoing ] Change Paralelism
Refresh Option L
Cther Actions ]
Drop
Export Data ¥

4.5 Consultar y actualizar tablas

Otra de las funcionalidades disponible es la de consultar los datos de las tablas y actualizarlos. Los datos
se nos presentan en una rejilla sobre la cual podemos realizar algunas operaciones de presentacion tales como:

e Ordenacion.

* Filtrado.

* Filas duplicadas.

e Vista de una sola tupla.

Sobre la rejilla con los datos podemos hacer las clasicas operaciones de insercién, modificacion y borrado
de tuplas de una manera muy intuitiva gracias a la interfaz que han desarrollado.

Tenemos mas posibilidades: tiene soporte para CLOBs y BLOBs, existe un sistema de tracking de los

cambios realizados sobre los datos mediante mensajes de log y cuenta con un constructor visual para formar
querys.
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JUGADOR_EW A,

MNOMERE

[CURSO '] r Select Columns r Create Where Clauze r Showy S2L |/ Wienn Results |
| |

a

COCHE

COMDUCTOR

EQUIPO _

EGUIPCOEDURME EQUIPO_LANDER

EGLIPO_EWA, Options

ECLIPC_L ARDER:

JUGADOR I_l | |

JUGADOREDURNE % CODEQUIPO ’

Tl B0
PLAR_TAELE
PRUEEA,
PRUEBA2 ' JUGADOR_LANDER
T9E0OTO0 .
T98E01TO0 Sptians
T99B02T00 i |
TOOE03TO0 ry CODJUGADOR
TQAB04TON V MOMBRE
Drag tables to the canvas to hegin.
Aplicar I [ Cancelar

4.6 Exportar datos, DDLs e importar datos

Otra de las caracteristicas resefiables de SQL Developer es la capacidad que tiene para exportar e

importar datos, asi como DDLs.

Para hacer uso de estas funciones se emplea la funcion deseada en el menu contextual del objeto para el
cual queramos exportar/importar. Por ejemplo, a la hora de consultar las opciones de exportacién de una tabla
de nuestra BD, las opciones disponibles son las siguientes:
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k i Import Cats
TEXT = Expart Data
b Sy Export DDL
IMSERT -
LOADER red Views
WML S
HTML ized Yiews Logs
WL=

Zave to File

Save to Zip File
Save toWarksheet
Save to Clipboard

Por el contrario, cuando queremos importar, la Unica opcion disponible es la de importar desde una hoja
de calculo de Excel.

4.7 Procesar comandos

Siempre son bienvenidas las ayudas para facilitarnos la tarea de depurar cédigo, y con esa idea en mente
podemos encuadrar las siguientes funcionalidades:

* Resaltado de la sintaxis.

« Funcionalidad “Code insight”. Nos dice los parametros de una funcidn, los posibles valores de
una variable o parametro etc.

« Alias de tablas insight.

« Ejecucién de un solo Statement.

« Formateo de cadigo.

e Historial de comandos ejecutados.

* Explain plan.

e Capacidad para mostrar las salidas de HTP y OWA.

« Copy&Paste en nuestro SQL de:

(0]

O o0 OoOOo

Snippets

Tablas/Vistas

Funciones y procedimientos

Todos los demas objetos de las Conexiones
SQL desde los informes
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Educspor  |[BEDD_CURSO  |(DHelp |

PERRe® &8Rd ¢

Erter SGL Statement:

select JUGADOR_LANDER.| from JUGADOR_LANDER

2 CODEQUIFD
COoDJUGADOR

4 |
Eﬁ- Results " & seript Output | EExplain | 3 Autotrace | DEMS Output |

Results:

También se incluye la capacidad de editar codigo PL/SQL. Esta funcionalidad cuenta con las siguientes

caracteristicas:

« Editor plenamente funcional. Tenemos acceso pleno a las capacidades de PL/SQL.
e Visor de Snippets de codigo.

e Formateador de cddigo.

* Resaltado de sintaxis.

e Code Insight. En concreto, autocompletado.

+ Editor de PL/SQL basado en ficheros.

Cualquier fichero con la extensién .pks o .pkb sera abierto con el editor de PL/SQL. Los usuarios pueden
editarlo, usar snippets de cédigo con él, compilarlo y salvar esos ficheros.
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F— Oracle SQL Developer : PACKAGE BODY DEMO.EMP._ ACTIONS Body@demo

File Edit  “iew Navigste Eun Debug: Source Tools  Help
BoEa 90 B0 O-0- - {=l
Dgconnections | [ERep.. | [ |[@EmerackBony  BFemP_scions  |[EEw_acTionsBody  [PoEorct | [4lkI~lg
- y i e
WY (@8- T & Eg
e 0
nections ! create or replace o
Barry_817 PACKAGE BODY enp actions AS =2
hdemo k tumber hired IMT: -- wisible only in this package =
{15 Tables
@ Wigws 3 /% Fully define cursor specified in package. /7 [
EE Ihdexes CURSOR desc_salary BETURH EnpRecTyp IS S
@ Packages - SELECT empno, sal FROM emp ORDER BY sal DESC: !ﬁ
-8 BANK_TRANSACTIONS s
E‘j% EMP_ACTIONS A% Fully define subprogreams specified in package. 7
=1 EMP_ACTIONS Body #  FUNCTION hire employee ...
number_hired —
| desc_salary [# PROCEDURE fire employee ...
hire_ermployee W AR
& fire_employee(nT) /% Define local function, available only inside package. %/
(e sal_ok(INT, RESL) - B E  FUHCTION sal ok ...
raize_salary(INT, INT
_ nth_highest_salaryl % PROCEDURE raise salary (ewp id INT, grade INT, smount REAL) IS
a8 EmpRecTyp salary BEAL:
a3 DeptRecTyp =  BEGIN
E desc_salary SELECT sal IWTO salary FROM emp WHERE empno = emp id;
: 8] irvvalid_salary IF sal ok{grade, salary + amount) THEH
----- hire_employeey ARCH UPDATE emp SET zal = sal + awount WHERE empno = emp id:
----- ire_employes = ELSE
=l i Ioyee(NT)
----- raise_salary(INT, INT, RE BAISE invalid salary;
P rith_highest_salary(NT) ;| - EHD IF; =
A | [»] |[4] EHD raize salary:
hire_etnployeely ARCHARZ, YARCHARZ, REAL, REAL, REAL, REAL)  IMT | Line 10 Column & | Insert : | Ui LF Editing

4.9 Ejecutar y depurar PL/SQL

Siguiendo en la linea del punto anterior, SQL Developer también permite ejecutar y debuggear cédigo
PL/SQL. Sus caracteristicas son:

e Ejecutar procedimientos, funciones y paquetes
o DBMS_OUTPUT
0 Valores de retorno de las funciones
o Parametros OUT
- Dialogo de ejecucion de PL/SQL
o Especificar target de ejecucion
0 Mostrar informacién de los parametros
0 Genera un bloque PL/SQL editable para rellenar los parametros
« Debugger plenamente funcional
o Controlar la ejecucién del programa (Step into, over,...)
0 Inspecciona y modifica variables
o0 Configura breakpoints condicionales
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3

EMP_IDI' HUMBER;
GRALDE HUMBER;
AMOUNT FLOAT ;

BEGIN
EMP_ID := HULL;
GRADE := HULL:

AMOUNT := HULL;

EMP_ACTIONS.RATSE SALARY |
EMP_ID =» EMP_ID,
GRADE => GRADE,

Ilarget: Parameters:
FIRE_EMPLOYEE Parameter | DataType | Made
2 AISE EMP_ID NUMEER: N
HIRE_EMPLOYEE GRADE NUMEER: IN
NTH_HIGHEST _SALARY AMOUNT FLOAT IN
PL/GL Block
DECLARE =

4]

[ »

[ Frarn File... l Reset ]

I

I (8] Cancel ]

4.10 Creary ejecutar informes

Una parte importante de SQL Developer es la de ejecucion y creacion de informes. La herramienta
presenta una serie de informes predefinidos que abarcan multiples aspectos tipicos de la base de datos. Sin
embargo, también existe la posibilidad de crear informes a medida.

* Informes preestablecidos

0 Sobre la base de datos : contiene informacion sobre la base de datos conectada en ese
momento, como se aprecia en la siguiente figura.

2 Connections EE_EHepnrts ]

= DBConnection_TEST ]\-"ersinnBanner ]

B[] Reports
=[] Data Dictionary Reports
=[] About Your Database
P FyEL Y ersion Banner
i o3 Mational Language Support Paramnst
I:I Database Adminigtration
[ Table
; £33 PLASAL
D Security

A 5

Y'our Databaze Settings

Oracledi Enterprize Edition Releaze 9.2.0.1.0 - Production
FL/SAL Releaze 9.2.0.1.0 - Production
CORES.2.0.1.0Pnoduction

TMS for 32-bit Windows: Wersion 9.2.0.71.0 - Production
MLSRTL Wersion 3.2.0.1.0 - Production
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o DBA: contiene varias subcarpetas. La primera de ellas es “Database Parameters” con la
opcién “All Parameters” (Reports->Data Dictionary Reports->Database Administration-
>Database Parameters->All Parameters) que devuelve una lista con todos los parametros
de inicializacion de la base de datos.

2 Connections

=L Reports
£+ Data Dictionary Feports

£ &bout Your Database

[ Database Admiristration

B[ Database Parameters

#jdReparts

“- 38 Mon-Default Parameters
D Storage

-7 Sessions

D Cursars

-7 &l Tables

B[ TopSAL

D Users

En la carpeta “Storage” (Reports->Data Dictionary Reports->Database Administration-

[=]| | DECornection_TEST

All Parameters

>
Paramater Mame | TvPE | Walue | Default | Session Modifiable

active_instance_count Integer TRUE FaLSE
anq_tm_processes Integer 1 FALSE FalLSE
archive_lag_target Integer 0 TRUE FALSE
audit_sys_operations Boolean  FALSE TRUE FALSE
audit_trail String HOME TRUE FALSE
background_core_dump Shing partial TRUE FalLSE
background_durmp_dest Sking C:horaclehadmintBD atoghbdump FALSE FALSE
backup_tape_io_slaves Boolean  FALSE TRUE FaLSE
bitmap_merge_area_size Integer 1048576 TRUE FaLSE

>Storage) se pueden recuperar mucha informacién sobre el almacenamiento de los datos

en la base de datos. Por ejemplo, a través de la opciéon “Free Space” (Reports->Data

Dictionary Reports->Database Administration->Storage->Free Space) se puede recuperar
el espacio disponible de uno o todos los tablespaces del sistema.

2 Connections

=[] Reports

=[] Data Dictionary Reports
B[] &bout four Database
-3 Wersion Banner

EF_E Reports

=

a
5. Database Admiristration
-] Database Parameters

o

9 Al Farameters

“ 778 Mon-Default Parameters
=[] Storage

-3 Tablespaces
‘|‘-§ Tablezpace Segments

9 Offline Tablespaces

ae Datafiles

AP9 Mational Language Support Parameters

E] [ DEConnection_TEST

> (5

Free Space

Tablezpace | Allocated MB | Used MB | Free MB | Llsedl [Data Files
BOAELAE 50,00 425 4575 9% 1
BOAELAE_LOB 100,00 0.E2 99,38 1% 1
BTU 10,00 1.25 275 12% 1
BTU_BLORE 10,00 E.25 178 B2% 1
COMP |.00 E.3 163 79 1
COMP_DATO g.00 0.0 L= . 4 1
COMP_DATORROD 5,00 182 338 32% 1
COMP_DATOS 5,00 1.75 325 3h% 1
COMP_DATOS2 .00 5.3 0.3 95% 1
COMP_IHDICE 7.aa 0.08 B34 1% 1
COMP_IMDICEPR... 7.aa 494 208 A% 1

Otra carpeta interesante es la de “Session”. Dentro de esta carpeta se pueden crear
informes para recuperar informacion sobre, por ejemplo, las sesiones activas en un
determinado momento. Para ello, se puede hacer clic sobre la opcién “The active sessions
report” (Reports->Data Dictionary Reports->Database Administration->Sessions->Active
Sessions) que muestra todas las conexiones activas en la base de datos. Se utilizara esta

informacion para saber que usuario esta logado y obtener detalles Sobre su sesion.
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g Corrections | a4 Reports [=]| [>» DBECornection_TEST | Sessions
=] Reports B =
-[7] Data Dictionary Reports ; - - -
1] About Your Database SesslonIDl Usemname | Seoonds in Wait| Command Maching 05 Usger St
T3 Yersion Barner 9L33 |ampurua |armpurua inan
23 Mational Language Support Parameters 12FCA PUESTO?724 gperez nar
Database Administiation 13L33 EUROHELF-BILEADYWFUESTO3SD0  jmalonso inan
[ Database Parameters 15 1BO4_US... pusstol g e
H g gtnlage 16 086 servidor21 roat inan
?Z‘Z:Zm S 17 Q70v2 EUROHELPEILBADSPUESTORED  jroncal =
a ession Counts by 05 User 18 FCA PUESTO?24 martinez inan
= 19133 jampurua jampurua inan
_f Sessions by Module 200370 FORMACIOM <PFORMAD cuso inar
—f Sessions by Username 21 Q72 SELECT EUROHELP-BILBADYPUESTOS10 iurkidi inar
% ﬁi‘;i:?:s‘z:’;s 23 070V2 SELECT EURDHELP-BILEAOSPLESTOGE  afuertes ina
_§ Background Sessions 24133 EUROHELF-BILBAOWPUESTO-DES. .. rminon inan
13 System Sessions 26 Q70V2 EUROHELP-BILEADNPLESTO00  irodiguez inai
El resto de subcarpetas que se encuentran en “Database Administration”, son muy
parecidas a las explicadas anteriormente (Storage, Session, etc.), pero mostrando la
informacion particular de cada carpeta. Asi, la herramienta proporciona carpetas para
hacer informes sobre cursores, tablas de la base de datos, usuarios registrados, etc. y la
forma de obtener informes de cada una de ellas es muy intuitiva.
Una carpeta que destaca por la utilidad de la informacién que devuelve, es la de “Top
SQL” (Reports->Data Dictionary Reports->Database Administration->Top SQL->*) que
ofrece una idea general sobre qué esta pasando en el sistema. Por ejemplo, se puede
obtener una lista de querys por consumo de CPU, por ejecuciones, lecturas de disco, etc.
2 Cornections ZFE Feports E] [ DBConnection_TEST Top SGL by CPU
{7 Feports P> |5
-7 Data Dictionary Feports ’ - -
E1-£3 About Your Database SaL CPU Seconds | Disk Reads | Buffer Gets | Executions | Buffer gets/rows
E]D Database Admiristration zelect t.schema, tname, tilags, q.name... 43,2969 213 111442 172 )
E1-£3) Database Parameters SELECT SEM_DN_10,C0D_TH_10,C... 3125 1089 EEREON 2 27
-] Storage update 07002500 set ID_SES=1.ATR... 3316875 464164 1364163 7.939
B[] Sessions select ID_SES, ATRIBUTO_SES, DAT... 20,0625 441493 717891 7.457
g% EILI"'I?D:I select Lname, [select owner_instance f... 17,3750 13 483711 B9.784
[_]::D TDDZ;LS select ID_SES. ATRIBUTO_SES, DAT... 172344 455648 638330 7.945
] Top L by CPU SELECT CODPAC_03,TO_CHAR[FEC... 46719 10331 20,696 104
'd Top SAL by Disk Reads select privileged level from syzauth$ co... 2 B85 33 37254 1.411
I3 Top SOL by Buffer Gets SELECT FILE_MAME . FILE_ID , TAE... 21875 62 4.409 45 2
Top SGL by Executions select q_name, state, delay, expiration, ... 2032 0 92 1]
& 8l Top SHL by Bulfer Gets/Rows Proc ||+ ouner "Ouner”, 1.9219 8087 EG534 1 11

Informes definidos por el usuario  (Ver Anexo 3: Ejemplo de creacién de informes
personalizados)

(0]

[0}
[0}
(0]

Tabulacién basica
Graficos

HTML

Scripts
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¥ Oracle SQL Developer

File  Ecit  Miewe Mavigste Bun Debug  Source Tools  Help
BoEg 90 XEM O-0- - a
D Connections |Elrep.. | [2]] | G@eMPrack Body | EBEMP_cTIONS | FBEMP_ACTIONS Body | (5] Emp per Manac |1|I]1! =
= aitreparts & >  Freteshio | HR_ORCL vz
EHE' Data Dichiohary Reports — 7‘ =l
00 Anout Your Database 180K —_52?
B-C3 Ak Objects 5
B-C3 Charts
m Database Administration TEOK
B3 Dats Dictionary _@
G Jdobs __%j.
E Security i
E‘_{j Streams 190K
{:] Table Series; Raphaely
B oM = Froup: King
El-l=- tiser Defined Reports 100K [ alue: 1100k
-0 18 tmposted Reparts
G Database Adeministration
B DemoReports B0k
Biazic Master Detail Repo
Drill Dowen Report 2 Emps
Dirill Diowenn Repott Top Deg 60K
T pIET eF
F-C0 MyRepartsFolder 40K
B3 PLsor
F-C3 sQr
B0 testolder 0k
E User Defined Reports
0K -
EZz3582383 TEEE
= ! = E = w w ] % | |
-
q N [
Repart Execution Time: 21 Sms | Edititgy

4.11 Migrar desde bases de datos de terceros.

Un aspecto que se ha intentado potenciar con las nuevas versiones de SQL Developer es el de migracion
de datos desde BBDD de terceros hacia nuestra BD Oracle. Para ello la herramienta viene equipada con las
siguientes caracteristicas:

e Crear conexiones para diferentes tipos de BDD
o MySQL
0 Microsoft SQL Server
0 Microsoft Access
* Navegar/examinar bases de datos de terceros
e Migracién rapida gracias a los asistentes incorporados
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« Migracién efectuada con los minimos privilegios posibles
e Migracién paso a paso
o Capturar el Modelo
o Convertirlo a un Modelo Oracle valido
o0 Generar script DDL
0 Ejecutar script DDL
0 Migrar datos a Oracle
« Migracién detallada.
* Incluye soporte para la migracion de objetos complejos como procedimientos, disparadores y
vistas.
« Editor para traducir los errores implementados.
* Visor de las diferencias encontradas en la traduccion.

Quick Migration

Step 1 - Source Connection Choose the conhection you would like to migrate lSQL_ServerZDDEI_Sa - | | Meswy ., |
from. If no third-party connections are available, click Mew to create a new one,

Step 2 - Target Connection Choose the target Oracle connection to use to !dbn_migrate = | | Metwye . |
migrate your database. Hote: For single-schema migrations, your neww objects ;
will be created in this uzers databasze. This user will need the folloswing rights:

1. RESCURCE
2. CREATE SESSION
3. CREATE VIBW

For multi-zcherma migrations, this user will be used to creste target databazes,
and it will need the following sdditionairights:

1. CREATE USER
2. BLTER ANY TRIGGER

Step 3 - Repository A repostory is needed during migration for storing Mo Reposttory is available. A repostory will be created i your target
captured and converted metadata. connection

D The repository will be removed once complete. Check here if you
wish to keep the repository

Step 4 - Pre-migration check Click Yerify to check that prerequizites have been met and to view the results, Werify

Test Status Infarmation

Help Cancel
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5 Utilidad Préactica

Tenemos entre manos una herramienta realmente completa. Con SQL Developer podemos conectarnos a
nuestra base de datos y examinarla en detalle, observando el contenido de las tablas, su estructura, la de los
procedimientos, indices, funciones, disparadores etc.

Oracle SQL Developer se recomienda en BBDD Oracle 9i y 10g , ya que para versiones superiores,
podra utilizarse Tora.

Con esta herramienta podremos visualizar, crear, modificar etc. de modo gréfico todo tipo de objetos
gracias a la sencilla e intuitiva interfaz de usuario que presenta la herramienta.

También podremos lanzar sentencias SQL, consultar y exportar sus resultados, formatear codigo, etc.

Cuenta ademas con capacidades de edicion ejecucion y debug de instrucciones PL/SQL asi como de
SQL*Plus. Para facilitarnos la tarea el editor es code insight, lo que quiere decir que contamos con ayuda de
autocompletado, informacion sobre tipos de datos requeridos en los parametros de una funcién, resaltado del
cadigo etc.

Por otra parte, también cuenta con un completo sistema de generacién de informes. Junto con la
herramienta tenemos un conjunto de informes predefinidos que abarcan los puntos mas tipicos como por
ejemplo informacién Util para realizar el mantenimiento de la BD. Pero no acaba ahi la cosa, sino que podemos
definir nuestros propios informes, con Unicamente los datos que nos interesen, afiadiendo gréficos, logrando un
aspecto visual atractivo gracias a que se generan mediante HTML, que podemos personalizar usando scripts.

Otro de los puntos fuertes de la aplicacion es la opcién que brinda de importar datos desde BBDD de

terceros. Se incluyen las mas difundidas, es decir, MySQL, SLQ Server y MS Access. El proceso de realizar las
migraciones se realiza a través de asistentes guiados, lo cual facilita en gran medida la tarea.

6  Anexo 1: Ejemplo Realizar un filtrado en una tabl a

Se va ha realizar un filtrado en la tabla S73A08T00 de la aplicacion s73a, esta tabla esta compuesta por
los siguientes campos:

# | Column Mame | Data Type MHULL Cornments
1|PRODUCTID  WARCHARZ [10) (MOT MULL
JCATEGORY WARCHARZ[10] (MOT MWULL
AMAME VaRCHaR2Z [20] (MULL
4DESCH WiaRCHARZ [255] MULL

Y el filtrado se va a realizar por el campo “CATEGORY”, seleccionando Unicamente aquellos registros de la
tabla que tengan la categoria de “DOGS".

6.1 Resolucion

Lo primero que hay que hacer una vez abierta la herramienta Tora, es conectarnos con la BD S73A,
seleccionamos la base de datos, e indicamos el usuario y la contrasefia para conectarnos.

24/33



- . .
Eusko Informatika Elk
l Sociedad Informatica del Gobierno Vasco

I New / Select Database Connection

Connection Name |3?3a | Connection Mame Connection Details
Lsername | petstare |
Paszward EREREERE |
[ save Passward
Role [defauﬂ ,l

(Eiasic |/TNS rAdvanced |

(5) Netwaork siss |PETSTORE -|

() Connect Idertitier

Status

[y ] [ Test ] [ Cannect I ’ Cancelar

Una vez realizada la conexion se muestra la interfaz para ver la tabla hay desplegar la conexién “s73a”,
luego los objetos tablas y por Ultimo seleccionar la tabla S73A08T00
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| Oracle SQL Developer

File Edit “iew Mavigate BRun DCebug Source Tools Help
e -9 8-
Dconnections | afsReports | (L] Prs73a  |[Fs73808T00 |
Eﬁ ‘i?' Columns | Data Indexes[tnnstrairrts]Grar‘ds]Statistics[C-:-Iumn StatisticsITriggers]Dependencies]Detail:
B30 Cornections » 7 Eﬁ Actions...
=B 5734 Column Mamel  DataTyps  |NullablelData Defaul COLUMM ID|Primary Keyl COMMENTS]
=-{F3 Tables PRODUCTID WARCHARZ(10 Byvtes) Mo 1 1
- [ CAMPOSDINAMICOS CATEGORY WARCHARZ(1D Bytes) Mo 2
B PLaN_TABLE MAME VARCHARZ(E0 B ¥ 3
- =73801T00 (80 Bytes) Ves
- 273800700 DESCH VARCHARZ(255 Byte... Yes 4

E

E

E

E

- sv3a03T00
- 73804700
- s73a05T00
- svaa0eTo0
E
E
E
E
E
E
E
E

-5 s7as0rTo0
R [a]
- 573809700
A5 s73s10T00
- s73811T00
i s7asq2T00
- s73813T00
- vaLoRES

]E Wiewys

- (18 Indexes
]@ Packages
]Eﬂ Procedures
H- [l Foinetioee

s [ B e O e OO

Ahora pinchando en la pestafia “Data” aparece una caja de texto para introducir el filtro a la tabla. Y una
vez escribimos la condicion de filtrado “CATEGORY='"DOGS™ se mostraran Unicamente los registros que
cumplan la condicion.

| Oracle 5QL Developer : TABLE PETSTORE.ST3A08TOD@s73a

File Edit “iew Mavigaste Bun Debug Source Toolz  Help
aa 06-0- §5-
Dconnections | faReports | )|Prs73a  |[Es73s0sTon |
E@ ? Columnzs m Indexes ]Cons’[rairﬂs IGrarrts lStatistics ICDIumn Statistics ]Triggers IDependencies ]Details @
=3 Corrections ADFPRESE o Fmer;|cmEGORv=-Does-
=B 573a PRODUCTIDICATEGORYINAMEDESCH
E1-{E3 Tables 1HS-BD-M DOGS  Bull.. =ina..
B camposoiamcos 2KSPOD2 DOGS  Poo... sima..
B pLan_T8BLE :
' =raa0i o0 IKS-DL-O1 DOGS  Dal.. <ima...
BB s73a0a700 4KI-RT-01 DOGS  Gol.. <ima...
A 7303700 SHO-RT-02 DOGS Lak... <ima..
A s73004100 BKI-CW01 DOGE  Chi.. <ima...

{H s7aansTo0
A s73a08T00
{H# syaa0rToo
- 73808700
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7  Anexo 2: Ejemplo exportacion

Se va ha realizar una exportacion de los datos de la tabla S73A08T00, y vamos a dejar el resultado en un
fichero denominado Datos08.sq|l.

7.1 Resolucion

Lo primero que hay que hacer una vez abierta la herramienta Tora, es conectarnos con la BD S73A,
seleccionamos la base de datos, e indicamos el usuario y la contrasefia para conectarnos.

F New / Select Database Connection i x|

Conrnection Mame Hs?Sa | Connection Name Connection Details

[
Userrame | petstore |

[
Pasgyvord Ixuxnx*

[ ] save Passweord

el !default >

[Basic | ™z | Advanced |

(%) Metwork Alias | PETSTORE dl

(] Connect Idertifier

Status -
| Ayuca ! [den ‘ | Test J Lannec’[ i I Cancelar ‘

Una vez realizada la conexion se muestra la interfaz para realizar la exportacion de la tabla primero hay
que ver la tabla, hay desplegar la conexién “s73a”, luego los objetos tablas y por Gltimo seleccionar la tabla
S73A08T00, pinchar con el botén derecho del raton y seleccionar “Export -> SQL Insert”
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m-{EE s7aa0gTon
&0 s7aa0g Bt

- =734
- s73m11 i
- 732 = : oy
wo srzany =
w-Ed vaLor|  Index 4
{88 Views Storage b Sl Loader
[H- Ea Indexes Statistics ] Text
E?I---@ Fackapes Conatrairt P
- 3 Procedures Brivieges b
[+ (i@ Functions _ \
F-{ @ Triggers Trigger
-3 Types

Y la aplicacién muestra la pantalla para realizar la exportacion, en esta pantalla indicamos el fichero en el
gue se crearan los scripts, ademas se pueden indicar las columnas a exportar y si se quiere alguna condicién de
filtrado.

§ Export Data - _ 5]

Format | Columns .ilh“ﬂﬂere |

|
Format (2 INSERT () XML () LOADER () €3 () TXT
Cutput (2) File () Clipboard

Table |S73AD8TO0 |

File: |.l'C:.l'datu:us.sc|I I EBrovese.. ]

Axuda Aplicar l I Cancelat
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Para el caso que nos ocupa ho es necesario, por lo que una vez seleccionado el fichero pinchamos en
“Aplicar” y los scripts son volcados en el fichero de la siguiente manera.

F— INZERTING into 373A08TOO

Insert
Insert
Insertc
Insert
Insert
Insert
Insert
Insert
Insert
Insertc
Insert
Insert
Insert
Insertc
Insert
Insert

into
intao
into
into
into
intao
into
into
into
into
into
into
into
into
into
into

nEYIA08TOON
"IYIA0STOON
"ETIA0STOOM
"33 AO0BTOOM
"EYIA0BTOO
"EYIA0STOO
"3YIA08TOON
"EYIA0BTOON
"3TIA0BTOO
"ETIA0STOOM
"ETIA0BTOON
"33 A0S TOON
TIYIA0sTOO"
"ETIA0STOOM
"EYIA08TOON
"3VIA0BTOO

[("PRODUCTID™,
{"PRODUCTID",
{"PRODUCTID",
[ "PRODUCTID™,
{"PRODUCTID™,
{"PRODUCTID™,
{"PRODUCTID",
{"PRODUCTIDY,
("PRODUCTID™,
["PRODUCTID",
{"PRODUCTIDY,
[ "PRODUCTID™,

"CATEGORY™,
"CATEGORY™
"CATEGORY",
TCATEGORYY,
"CATEGORY"™,
"CATEGORT"
"CATEGORY",
"CATEGORYY
"CATEGORY"™,
"CATEGORY",
"CATEGORY™
"CATEGORYY,

"HAME™, "DE3CN")
"HAME™, "DE3CHN™)
"NAME™, "DEICH™)
"HAME™, "DEICHN")
"NAME™, "DESCHN™)
"HAME™, "DE3ICH™)
"HAME™, "DESCHN™)
"HAME™, "DE3CHN")
"HAME™, "DE3CHN")
"NAME™, "DEICH™)
"HAME™, "DE3CHN™)
"HAME™, "DE3CHN™")
("PEODUCTID™, "CATEGORY™, "NAME™, "DESCH™)
("PRODUCTID, "CATEGORY", "NAME™, "DESCN"™)
("PRODUCTIDY, "CATEGORY™, "NAME™ "DESCHN™)
({"PRODUCTIDY, "CATEGORY™, "NAME™, "DESCH")

values
values
values
values
values
values
values
wvalues
values
values
values
values
values
values
values
values

['FI-ZU-01', 'FISH','Angelf
['FI-ZW-02', 'FISH', Tiger

['FI-Fy-01','FISH', 'Koi',

['FI-FW-02', 'FISH', 'Goldfi
{'K9-ED-01', 'DOGS', 'Bulldo
['E9-PO-D2','DOGS' , ' Poodle
{'K9-DL-01', 'DOGS' , ' Dalmat
{'K9-RT-01', 'DOGE', ' Golden
['K9-RT-02', 'DOGS' , ' Labrad
[TK9-CW-01', 'DOGS', 'Chihua
['RP-3N-01', 'REPTILES', 'Ra
[*"RP-LI-02', 'BEPTILES','Ig
('FL-DSH-01', 'CATS', ' Manx'

{'FL-DLH-02','CATS', Persi
{'AV-CB-01', 'BIRDS',' hmazo
(' AV-3E-02', 'BIRDS', Finch
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8  Anexo 3: Ejemplo de creacion de informes personal  izados

Se va ha realizar un ejemplo en el que se mostrara como crear informes personalizados a partir de
consultas a tablas de la base de datos.

8.1 Resolucién

En este ejemplo se parte de dos tablas de la base de datos L33:
e L3306T00: Contiene datos de las unidades (centros) a los que puede pertenecer un declarante
(médico).
e L3307T0O0: Contiene informacion sobre declarantes (médicos).
Lo que se pretende es conseguir una grafica que muestre los salarios de todos los médicos por cada uno
de los centros. Para acotar los datos, s6lo se mostrara informacion de los médicos de dos centros: U20 (C.S.
GANGOITI) y U21 (C.S.GAZTELEKU).

La query que obtiene los datos que se van a mostrar en la gréafica es la siguiente:

SELECT
Tb1.NOM_DE_07, Tb2.DES_UN_06,Tb1.SEM_DE_07

FROM L33.1.3307T00 Th1, L33.L3306T00 Th2

WHERE Th2.ANO_UN_06=Tb1.ANO_DE_07 AND
Tb2.COD_TH_06=Th1.COD_TH_07 AND
Tb2.COD_MU_06=Th1.COD_MU_07 AND
Tb2.COD_UN_06=Th1.COD_UN_07 AND
(Th2.COD_UN_06="U20'OR Tb2.COD_UN_06='U21")

GROUP BY Th2.DES_UN_06, Tb1.NOM_DE_07, Tb1.SEM_DE_0 7

Con toda esta informacién ya se puede empezar a crear el informe en SQL Developer.

El primer paso que se debe dar es crear un nuevo Report pinchando con el botén derecho del ratén sobre
“User Defined Reports”.
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4 Connections ] Repaorts E]
&ll Reports

-z Data Dictionary Reparts
-3 About Your Database
-3 All Objects

#-{3 Application Express

&-£3 Charts

-3 Databaze Administration
-3 Data Dictionary

E Jobs

w3 PLSAL

£ Securty

#-£3 Streams

E Table

E-£3 XML

-3 Shared Reports

----- (= User Defned Reporte

Copy

[] Paste

2 &dd Folder

B Add Report

Impart

Export

En el menu desplegable se selecciona “Add Report” y se mostrara la pantalla de creacion del informe. En
esta pantalla se rellena el nombre del informe, la descripcion y la query en el campo SQL. En este ejemplo los
valores seran los siguientes:

* Name: Salario de cada declarante por cada centro (centros controlados: U20 o U21
e Description: Qué salario tiene cada declarante que trabaja en el centro U20 o en el U21

Query para esta blsqueda:

SELECT
Tbh1.NOM_DE_07, Th2.DES_UN_06,Tb1.SEM_DE_07

FROM L33.L3307T00 Th1, L33.L3306T00 Th2

WHERE Th2.ANO_UN_06=Tb1.ANO_DE_07 AND
Tb2.COD_TH_06=Th1.COD_TH_07 AND
Th2.COD_MU_06=Th1.COD_MU_07 AND
Th2.COD_UN_06=Th1.COD_UN_07 AND
(Th2.COD_UN_06="U20'OR Th2.COD_UN_06="U21")

GROUP BY Th2.DES_UN_06, Th1.NOM_DE_07, Tb1.SEM_DE_0 7
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¥ Create Report Dialog @

M astell

Marne | S slanio de cada declarante por cada centro [centros controlados: U20 o U21) J Style [Chart V]
Dexcription | AuB® salario tiene cada decalarante que trabaja en el centro 20 0 en el U121 |
Taaltip | |
SaL

SELECT
Tbl.NOM _DE_07, TbZ.DES_UN_06,Thl.SEM DE_07
FROM L33.L3307TO0 Thl, L33.L3306TO0 Th2
WHERE ThZ.AN0_UN_06=Thl.AN0 DE_07 AHD
TbZ.COD_TH_06=Tbl.C0D_TH_07 AHD
TbZ.COD_MU_06=Tbl.COD_ MU 07 AHD
ThZ.COD_UN_06=Th1.COD_TH_07 AHD
{TbZ.COD_UN_06='U20'0R ThZ.COD_TH_06='T21" )
GROUP BY Th2.DES UN_06,Tbl.NOM DE_07,Tbl.SEM_DE_O7

[»

[

4 IC

Test Load

Details‘l Columns] Bindz [Advanced | Chart Details|

[ Aplicar ] [ Cancelar ]

En la lista desplegable “Style” se puede seleccionar el estilo del informe (table, chart, etc.). Si se
selecciona Style=Chart, aparecera la pestafia “Chart Details”. En esta pestafia se pueden configurar algunas
caracteristicas del grafico que se va a obtener.
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Mastar]

Crat e [iVERTGET <]
Whaph (e
Gradient Effect _
ChatStle  [Defak  ~]

Show Grid fake -

ShowLegend | fajee -

Dretailz [CUIumns] Binds {Advanced“ Chart Delai\s]

El resultado final sera el que se muestra en la siguiente figura:

F Oracle SQL Developer Z | Dlil
File Edit “iew Navigste Run Debug Source Migration Toolz  Help
; - . - 1o
GeoEag 90 xBau 0-0- 9 i
ﬁiConnectlons Eﬁepo_rts_ 1 [;] D DEConnection_TEST ] @Salano de cada declarante por cada centro [centros controlados: U120 o LI21) | |3
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{3 Data Dictionary Reports
-
11 [ Shared Reports 12 —]
[=-{2 User Defined Reports
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